
Lesson 6: Working with PowerPoint Objects
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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Draw Simple Lines and Shapes
	6-1
	Click the appropriate Drawing toolbar button (Line, Rectangle, or Oval) and then drag the crosshair pointer on the slide until the object is of the required size.
	Opening1.ppt
	None

	Delete Objects
	6-2
	Select the object and press [Delete].
	None
	None

	Draw Horizontal, Vertical, and Other Constrained Lines
	6-3
	Double-click the Line button. Press [Shift] and drag the pointer straight across to draw a line. Release the mouse button first, and then release [Shift]. Press [Shift] again and drag to draw another line. Release the mouse button first, and then release [Shift]. Repeat the process till the required number of horizontal, vertical, and other constrained lines are created.
	None
	Sol6-3.ppt

	Create Squares and Circles
	6-4
	Click the Rectangle button. Position the crosshair pointer on the slide. Press [Shift] and drag the pointer diagonally to create a rectangle. Release the mouse button first, and then release [Shift]. Click the Oval button. Position the crosshair pointer on the slide. While pressing [Shift], drag diagonally to create a circle.
	None
	None

	Change the Size and Position of Objects You Draw
	6-5
	Select the object by clicking anywhere inside it. Point to any of the sizing handles. When the pointer changes to a two-pointed arrow, drag the handle by pressing the [Ctrl] or [Shift] key or pressing both the keys to change the size of the object.
Point anywhere in the object. When the pointer changes to a four-pointed arrow, click and drag to the object to reposition it.
	None
	Sol6-5.ppt

	Resize Objects by Using the Format AutoShape Dialog Box
	6-6
	Right-click the object and choose Format AutoShape from the shortcut menu. Click the Size tab. Under Scale, check the Lock aspect ratio check box. Make the relevant changes in the Height and Width text boxes under the Size tab. Click OK.
	None 
	None

	Create AutoShapes
	6-7
	Click AutoShapes on the Drawing toolbar to display the AutoShapes menu. Select one of the options from the AutoShapes menu to open its submenu. Double-click a relevant shape to add it on the slide.
	None
	None

	Change an AutoShape
	6-8
	Select an object. Click Draw on the Drawing toolbar to display the menu. Choose Change AutoShape and then select the new shape from any of the submenus.
	None
	None

	Place Text in an AutoShape
	6-9
	Select an AutoShape on the slide and key text.
	None
	Sol6-9.ppt

	Rotate an AutoShape
	6-10
	Select an AutoShape. Press [Shift] and drag the green rotation handle to the relevant angle.
	None 
	Sol6-10.ppt

	Find and Modify a Clip Art Search
	6-11
	Click the Insert Clip Art button on the Drawing toolbar. In the Insert Clip Art task pane, select the Search in options. Choose Clip Art from the Results should be options. Key the search topic in the Search for text box, and then click Go.
	None
	None

	Preview and Insert Clip Art
	6-12
	Point to a clip art thumbnail in the task pane. Click the gray bar to display a menu of options. Choose Preview/Properties.
To insert clip art, click a thumbnail in the task pane.
	None
	None

	Insert a Picture from File
	6-13
	Click the Insert Picture button on the Drawing toolbar. In the Insert Picture dialog box, locate the picture to be inserted and click Insert.
	None
	None

	Rearrange and Delete Clip Art Images
	6-14
	Click an image to select it and when a four-pointed arrow appears, drag the image to a relevant position. Select a clip art image and press [Delete] to remove it from the slide.
	None
	Sol6-14.ppt

	Copy a Clip Art Image from Another Slide
	6-15
	Click an image to select it. Click the Copy button to copy the picture to the clipboard. Move to the destination slide and click the Paste button.
Select an image and press [Ctrl]+[D] to duplicate the image.
	None
	None

	Add a Picture to a Slide Master
	6-16
	Select the clip art images and click the Copy button. Display the slide master. Click the Paste button. Close the Master view. 
	None
	Sol6-16.ppt

	Resize a Clip Art Image
	6-17
	Select the image by clicking it, and then place the pointer on any of the sizing handles. When the pointer changes to a vertical two-pointed arrow, drag the handle to resize the image.
	None
	Sol6-17.ppt

	Change Clip Art Image Settings
	6-18
	With the picture selected, click the Format Picture button on the Picture toolbar. In the Format Picture dialog box, make the relevant changes. Click OK.
With the picture selected, use the buttons on the Picture toolbar to change the image settings.
	None
	None

	Crop an Image
	6-19
	Select a picture. Click the Crop button on the Picture toolbar. When the pointer changes to a cropping tool, click and drag the any of the cropping handles until the dotted cropping line is positioned at the relevant location.
	None
	Sol6-19.ppt

	Create and Modify a WordArt Object
	6-20
	Click the Insert WordArt button on the Drawing toolbar. In the WordArt Gallery dialog box, choose a WordArt style. Click OK. In the Edit WordArt Text dialog box, key text and click OK.
Click the WordArt Shape button on the WordArt toolbar and choose an option.
	None
	None

	Edit WordArt Text
	6-21
	Select the WordArt object. Click Edit Text on the WordArt toolbar. Change the text and format it. Click OK.
	None
	None

	Add WordArt to a Slide Master
	6-22
	Right-click the WordArt object and choose Copy from the shortcut menu. Display the slide master. Click on the blank area on the slide master and choose Paste from the shortcut menu. Close the Master view.
	None
	Sol6-22.ppt

	Use drawing tools to create simple and constrained AutoShapes, key text in an AutoShape, and use the Format AutoShape dialog box.
	6-23
	
	Seminar1.ppt
	Sol6-23.ppt

	Insert and size a picture from a file, work with slide masters, adjust its contrast and brightness, and create a WordArt text object.
	6-24
	
	Seminar2.ppt, Logo1.jpg
	Sol6-24.ppt

	Insert clip art, adjust picture image settings, and crop a clip art image.
	6-25
	
	Seminar3.ppt, Logo1.jpg
	Sol6-25.ppt

	Create AutoShapes, add text to an AutoShape, rotate text and AutoShapes, and adjust image settings on a photograph.
	6-26
	
	Seminar4.ppt 
	Sol6-26.ppt

	Work with lines, AutoShapes, and clip art.
	6-27
	
	Market1.ppt
	Sol6-27.ppt

	Create a presentation from a Word outline, add an image to the title master, create and rotate a text box, and create an AutoShape containing text.
	6-28
	
	Cooking1.ppt
	Sol6-28.ppt

	Insert and rotate a picture from a file, add photo images to the slide master, and insert WordArt.
	6-29
	
	Recruit1.ppt, Logo1.jpg
	Sol6-29.ppt

	Use drawing tools and AutoShapes, and insert pictures and WordArt.
	6-30
	
	Funding1.ppt, Logo1.jpg, Miami1.jpg
	Sol6-30.ppt

	
	6-31
	
	Seminar1.ppt
	None

	
	6-32
	
	None
	None

	
	6-33
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 6.1

Working with Drawing Tools
This section focuses on:

· Drawing Simple Lines and Shapes
· Deleting Objects
· Drawing Horizontal, Vertical, and Other Constrained Lines
· Creating Squares and Circles
· Changing the Size and Position of Objects You Draw
· Resizing Objects by Using the Format AutoShape Dialog Box

Section 6.2

Using AutoShape Tools
This section focuses on:

· Creating AutoShapes
· Changing an AutoShape
· Placing Text in an AutoShape

· Rotating an AutoShape

Section 6.3

Inserting Clip Art
This section focuses on:

· Finding and Modifying a Clip Art Search
· Previewing and Inserting Clip Art
· Inserting a Picture from File
· Rearranging and Deleting Clip Art Images
· Copying a Clip Art Image from Another Slide
· Adding a Picture to a Slide Master
Section 6.4

Adjusting Clip Art Size and Image Settings
This section focuses on:

· Resizing a Clip Art Image
· Changing Clip Art Image Settings
· Cropping an Image
Section 6.5

Using WordArt for Special Effects
This section focuses on:
· Creating and Modifying a WordArt Object
· Editing WordArt Text
· Adding WordArt to a Slide Master
	Lecture Outline
	Lecture Notes

	Working with PowerPoint Objects
An effective slide presentation uses more than text alone. Although text carries most of the information, several types of objects can be used to emphasize the message and draw attention to the presentation.
Section 6.1
Working with Drawing Tools
The PowerPoint Drawing toolbar provides several tools to create drawings.
The ruler can be helpful when drawing a specific sized object. When the rulers are displayed, a dotted line on each ruler indicates the horizontal and the vertical position of the mouse pointer, measured from the center of the slide.
Drawing Simple Lines and Shapes
Some of the Drawing toolbar buttons used for drawing simple lines and shapes are:
· Line

· Rectangle

· Oval

When the drawing buttons are clicked, a crosshair pointer appears that can be dragged by the user to draw an object of the required size.

Multiple objects can be drawn by double-clicking a Drawing toolbar button. Double-clicking keeps the button activated, so users can draw as many shapes as they want without clicking again. When they finish drawing, they need to click the button again to deactivate it.

Deleting Objects
An object can be deleted by selecting it and then pressing the [Delete] key.
Drawing Horizontal, Vertical, and Other Constrained Lines
Users can press [Shift] to constrain an object as they draw it on a slide.

Constraining lines enables users to make straight horizontal, vertical, or angled lines. With this feature, lines are limited to angles in increments of 15 degrees.
Creating Squares and Circles
When objects such as rectangles or ovals are constrained, they grow at an equal rate horizontally and vertically as the users draw creating symmetrical objects such as squares and circles.
Changing the Size and Position of Objects You Draw
An object can be resized by first selecting it and then dragging one of its sizing handles.
Pressing [Shift] and/or [Ctrl] while dragging a sizing handle has the following effects on an object:

· [Shift] preserves an object’s proportions, meaning that its height grows or shrinks at the same rate as its width, preventing objects from becoming too tall and skinny or too short and wide.

· [Ctrl] causes an object to grow or shrink from the center of the object, rather than from the edge that is being dragged.

· [Ctrl]+[Shift] together causes an object to grow or shrink proportionately from its center.

An object can be repositioned by dragging it with the four-pointed arrow.

· Users need to point anywhere in the object.

· When a four-pointed arrow appears, they need to drag the object to another place on the slide.

Resizing Objects by Using the Format AutoShape Dialog Box

The Format AutoShape dialog box is opened by right-clicking an object and choosing Format AutoShape from the shortcut menu.
In the Format AutoShape dialog box, under Scale, the Lock aspect ratio option will force the height and width of an object to change the size at the same rate.


	Lesson Key Objective

Creating, inserting, and modifying objects and pictures in PowerPoint.

[image: image1.emf]Work with Drawing  Tools
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Teaching Tip:

You can use the ruler indicators to draw, size, and position objects.


[image: image3.emf]Draw Simple Lines  and Shapes


Text Figure: F06-01
Teaching Tip:

Discuss the use of all the Drawing toolbar buttons demonstrating their functions.
Additional Notes:

The green handle just above the shape that is drawn using the drawing toolbar buttons is a rotation handle. It can be used to rotate a shape.
Additional Notes:

When using [Shift] to constrain an object, it is important to release the mouse button before releasing [Shift]. Otherwise, you might accidentally move the mouse when [Shift] is no longer in effect, resulting in an object that is no longer constrained.

[image: image4.emf]Change the Size and  Position of Objects


Teaching Tip:

While constraining lines, ensure that students drag right and left, as well as up and down, before releasing, to get the feel of the 15-degree increments in the diagonal line, so they understand the concept of constrained lines.

Teaching Tip:

If squares appear distorted, have students check the size by opening the Format AutoShape dialog box and clicking the Size tab. The height and width should have the same measurement.

Text Figure: F06-02

Text Figure: F06-03

Teaching Tip:

Ask students to experiment with drawing when both [Shift] and [Ctrl] are pressed. Explain that pressing [Ctrl] while dragging makes an object grow in all directions from the starting point.
Additional Notes:

Whenever you drag to move an object or text, make sure you are not dragging a sizing handle by mistake. You must see the four-pointed arrow, and not the two-pointed arrow.

Text Figure: F06-04

Text Figure: F06-05



	Section 6.2

Using AutoShape Tools
PowerPoint provides an assortment of predefined shapes called AutoShapes. AutoShapes can be used to draw perfectly shaped arrows, stars, flowchart objects, callouts, and other shapes. These shapes can be resized the same way other objects are resized.

Many shapes include an additional yellow diamond handle, called an adjustment handle, which can be used to reshape the object after it is drawn.
Creating AutoShapes
Users can access a large assortment of basic and specialized AutoShapes by clicking AutoShapes on the Drawing toolbar and choosing from a menu of AutoShape categories. 
Changing an AutoShape
An AutoShape can be changed by clicking Draw on the Drawing toolbar, and then choosing Change AutoShape from the menu.
Placing Text in an AutoShape

An AutoShape can be easily transformed into an attention-getting background for text. Users need to simply select the AutoShape and key the text (or paste it from the clipboard).

Users can format and edit the text in the same way as in a text placeholder. The text in an AutoShape is centered by default. 

Rotating an AutoShape
An AutoShape can be rotated by selecting it and then pressing [Shift] and dragging the green rotation handle to the relevant angle.

	
[image: image5.emf]Create AutoShapes


Teaching Tip:

Use [SHIFT] to create a symmetrical AutoShape in the same way that you use [SHIFT] when you draw a circle or square.

Text Figures: F06-06, F06-07
Teaching Tip:

Point out the convenience of the Change AutoShape command. You can use this to change a shape, including one that already has text in it. In addition, you can use it to change the shape of a text placeholder.

Teaching Tip:

Encourage students to explore the various shapes available within each AutoShape category. You might explain how the Action Buttons category can be used to create hyperlinks in a presentation, or how connector lines work.

Text Figure: F06-08


[image: image6.emf]Rotate an  AutoShape


Text Figure: F06-09

Teaching Tip:

Students can drag the I-beam over the text to select it, and then format it, or they can click the border, and then apply formatting. Remind students of the other ways to select the entire AutoShape object by using [Esc] or [Tab].

Text Figure: F06-10

Additional Notes:

If text is keyed directly into an AutoShape, the text will rotate along with the AutoShape. If text is keyed in a separate text box that is placed on top of an AutoShape, the text box must be rotated separately. 

When objects are grouped, the group rotates as if it were one object.


	Section 6.3

Inserting Clip Art
Microsoft Office has a collection of ready-to-use images known as clip art that users can insert on PowerPoint slides. 
The clip art collection includes:

· Vector drawings — images made up of lines

· Curves
· Shapes
· Bitmap pictures — photographs made up of tiny colored dots that are made from scanned photographs or a digital camera.

Clip art and picture images can be inserted into a PowerPoint presentation in the following ways:
· Clicking the Insert Clip Art button on the Drawing toolbar to display the Insert Clip Art task pane.
· Using the Insert menu (Picture, Clip Art) to display the Insert Clip Art task pane.

· Using the Insert Picture button on the Picture toolbar to insert picture files stored on a hard drive, floppy disk, or network drive. This method is useful for inserting users’ own images that they have stored on the computer and that are not part of the Microsoft Clip Organizer collection.

· Double-clicking the Insert Clip Art button in the content placeholder, if the slide uses a content layout that includes a content placeholder.

Finding and Modifying a Clip Art Search
Each clip art image that Microsoft provides has keywords associated with it. These keywords describe the subject matter of the picture. Users need to search for the keywords to find the art they need for their presentation.
Clip art and other media such as photographs, sound, and movie files are organized into collections and media types. Users can choose to search all collections and types or to select a particular type.

In the Insert Clip Art task pane, when the Everywhere option is checked in the Search in list, it means that all categories in the Microsoft Clip Organizer will be searched and, if users are connected to the Internet, the Microsoft Office Online will also be searched.

Previewing and Inserting Clip Art
Users can preview images in a larger format, so that they can see more detail before choosing a picture.
The Preview/Properties dialog box not only displays an enlarged picture but also shows the file name and location of the picture, its size, and other helpful information.
Clicking the Next and Previous buttons below a picture in the Preview/Properties dialog box displays the next and the previous picture in the search results pane.
Inserting a Picture from File
Images can be directly inserted from devices such as scanner or digital camera that are connected to the computer.
Users can work with bitmap (digital) images in the following ways:

· Users can insert an image directly into a slide, by setting up the picture in the scanner or setting up the camera, opening the Insert menu, and choosing Picture, From Scanner or Camera.
· Users can insert a digital image that is stored on a disk drive, by opening the Insert menu and choosing Picture, From File. In the Insert Picture dialog box, they need to locate the picture file and click Insert.

· Users can insert a digital image that is stored on a disk drive, by clicking the Insert Picture button on the Drawing toolbar. In the Insert Picture dialog box, they need to locate the picture file and click Insert.

Rearranging and Deleting Clip Art Images
Moving clip art is similar to moving a text placeholder or an AutoShape. 
Users can move a clip art image by clicking to select it and then dragging it to the relevant position when the four-pointed arrow appears.

Users can remove a clip art image from a slide by selecting the image and pressing [Delete].

Copying a Clip Art Image from Another Slide
Users can cut, copy, and paste pictures in the same way as they cut, copy, and paste text. The Cut, Copy, and Paste buttons on the Standard toolbar are used for this purpose.

With an image selected, pressing [Ctrl]+[D] will duplicate the image.

Adding a Picture to a Slide Master
Users can add pictures, AutoShapes, and other objects to a slide master in the same way as they add objects to a presentation slide. Images can be inserted directly, or can be pasted from the clipboard.

	
[image: image7.emf]Preview and Insert  Clip Art

 
[image: image8.emf]Insert a Picture From  File


Teaching Tip:

Ensure that the Office 2003 clip art has been installed with the software. Also, ensure that the computers are connected to the Internet for a rich selection of clip art.
Text Figures: F06-11, F06-12
Additional Notes:

If you know that you want a photograph only, be sure to select that type of media only to make the search faster and more efficient.
Additional Notes:

Clips from the Microsoft Office Online collection have an online icon in the lower-left corner of the image thumbnail. Some of these clips also contain a musical note, indicating that they are sound files. Some clips have an animation icon displayed in the lower-right corner, indicating that they are movies.
Text Figure: F06-13
Additional Notes:

If you have both a camera and a scanner attached to your computer, choose the device from the drop-down list, and then choose Web Quality or Print Quality. Click Insert or Custom Insert. You can then use the tools on the Picture toolbar to adjust the image.
Text Figure: F06-14

[image: image9.emf]Copy a Clip Art  Image from Another Slide

 
[image: image10.emf]Add a Picture to a  Slide Master




	Section 6.4

Adjusting Clip Art Size and Image Settings
Users can change the look of clip art images in many ways, including changing the size, contrast, and brightness. The Picture toolbar is used for this purpose.
Resizing a Clip Art Image
Resizing a clip art image is similar to resizing a text placeholder or an AutoShape. The only difference is that with a clip art image, users can drag a corner handle without distorting proportions, even if they do not press [Shift].
Changing Clip Art Image Settings
When a picture on a slide is selected, the Picture toolbar usually appears. The Picture toolbar can be used to control various aspects of an image’s appearance, such as size, brightness, contrast, and color.
If the Picture toolbar is not displayed on selecting a picture, users can:
· Right-click the picture and choose Show Picture Toolbar from the shortcut menu.
· Click the View menu, choose Toolbars, and then select Picture from the list of toolbars.
· Right-click any toolbar and select Picture from the list of toolbars.
Cropping an Image
The Picture toolbar contains a tool that can be used to crop (trim) parts of a picture.
When the cropping tool is clicked, a picture’s sizing handles change to cropping handles and corners that can be dragged to trim the picture.

	Teaching Tip:

Explain the functions of the various buttons on the Picture toolbar.
Teaching Tip:

Ask students to experiment by dragging any resize handle. You can have students click Undo or click the Reset Picture button on the Picture toolbar to restore the original picture.

Text Figures: F06-15, F06-16

[image: image11.emf]Change Clip Art  Image Settings

 
[image: image12.emf]Change Clip Art  Image Settings



[image: image13.emf]Crop an Image


Text Figures: F06-17, F06-18
Additional Notes:

For proper cropping of images and fine-tuning the picture’s position, the [Ctrl] and [Alt] keys can be used.



	Section 6.5

Using WordArt for Special Text Effects
WordArt can create special effects with text that are not possible with standard text-formatting tools. Users can stretch or curve text, and add special shading effects, dramatic 3-D effects, and much more. Since WordArt creates drawn objects, drawing tools can be used to modify and enhance WordArt objects.
Creating and Modifying a WordArt Object
WordArt objects are not checked by the spell-checker. PowerPoint treats them as drawing objects, not text. Users need to ensure that they key and proofread WordArt objects carefully.
To open the WordArt Gallery dialog box, users need to click the Insert WordArt button on the Drawing toolbar.

Editing WordArt Text
WordArt text can be edited only in the Edit WordArt Text dialog box. The Edit WordArt Text dialog box is opened by:

· Clicking Edit Text on the WordArt toolbar, or 

· Double-clicking the WordArt object.
Adding WordArt to a Slide Master
To make a WordArt object appear on each slide, users can place it on the slide master, just like a picture is placed on a slide master.

	Teaching Tip:

Explain the functions of the buttons on the WordArt toolbar.


[image: image14.emf]Change and Modify a  WordArt Object


Text Figures: F06-19, F06-20
Additional Notes:

If the WordArt toolbar does not appear, you can use the View menu to display it.
Text Figure: F06-21

[image: image15.emf]Add WordArt to a  Slide Master
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